
Citrix ICA Client for Windows CE
Handheld PCs
Version 4.1

User’s Guide

Citrix Systems, Inc.



2  User’s Guide

Information in this document is subject to change without notice. Companies, names, and data used in
examples herein are fictitious unless otherwise noted. No part of this document may be reproduced or
transmitted in any form or by any means, electronic or mechanical, for any purpose, without the
express written permission of Citrix Systems, Inc.

© 1994-1999 Citrix Systems, Inc. All rights reserved.

© 1985-1997 Microsoft Corporation. All rights reserved.

Citrix, Independent Computing Architecture (ICA), MultiWin, DirectICA, SecureICA, Program
Neighborhood, MetaFrame, and WINFRAME are registered trademarks or trademarks of Citrix
Systems, Inc. in the U.S.A. and other countries.

Microsoft, MS, MS-DOS, Windows, Windows NT, and BackOffice are either registered trademarks
or trademarks of Microsoft Corporation in the United States and/or other countries.

All other Trade Names referred to are the Servicemark, Trademark, or Registered Trademark of the
respective manufacturers.

Document Code ctxuk.cehpc.0799.adm



Citrix ICA Client for Windows CE  3

Contents

Before you Begin................................................................................................................ 5
Who Should Use this Manual.................................................................................. 5
How to Use this Guide ............................................................................................ 5
Conventions............................................................................................................. 6
Finding More Information....................................................................................... 7
Citrix on the World Wide Web ............................................................................... 7
Year 2000 Readiness............................................................................................... 7

Introduction to the Citrix ICA Client for Windows CE..................................................... 8
Overview ................................................................................................................. 8
Requirements........................................................................................................... 8
Features ................................................................................................................... 8

Client Device Mapping ...................................................................................... 9
Client Drive Mapping................................................................................... 9
Client Printer Mapping ................................................................................. 9
Client COM Port Mapping ........................................................................... 9

Virtual Screen Panning ...................................................................................... 9
Sound Support.................................................................................................. 10
Data Compression............................................................................................ 10
ICA Client Hotkeys.......................................................................................... 10
Transparent Clipboard Access ......................................................................... 10
Client Auto Update .......................................................................................... 10
Published Application Support ........................................................................ 11
Business Recovery ........................................................................................... 11

Using the Citrix ICA Windows CE Client ........................................................................ 12
Overview ............................................................................................................... 12
Installing the ICA Windows CE Client................................................................. 12
Uninstalling the ICA Windows CE Client ............................................................ 13
Starting the ICA Windows CE Client ................................................................... 13
Creating a New Connection Entry......................................................................... 13
Connecting to a Citrix Server................................................................................ 16

Configuring the  Citrix ICA Client for Windows CE....................................................... 17
Overview ............................................................................................................... 17
Changing a Connection Entry ............................................................................... 17



4  User’s Guide

Specifying an Application to Run after Connecting to a Citrix Server............ 18
Specifying Logon Information......................................................................... 19
Changing the Window Properties .................................................................... 20
Setting Connection Entry Options ................................................................... 21
Configuring Business Recovery....................................................................... 22
Configuring Firewall Settings.......................................................................... 24

Configuring the ICA Client to Use a SOCKS Proxy.................................. 24
Configuring Alternate Address Translation................................................ 25

Changing the Global Settings................................................................................ 26
Configuring Hotkeys........................................................................................ 27
Configuring Global Preferences ...................................................................... 28

Preparing for Client Auto Update ......................................................................... 29
Using Local Printers.............................................................................................. 30

Index ...................................................................................................................................32



Citrix ICA Client for Windows CE  5

Before you Begin

Who Should Use this Manual
This manual is for system administrators responsible for configuring, deploying,
and maintaining Citrix ICA Clients for Windows CE in handheld and palm-sized
PCs. This manual assumes knowledge of:

� Citrix MetaFrame or Citrix WINFRAME

� The Windows CE Handheld PC
� Installation, operation, and maintenance of network and asynchronous

communication hardware, including serial ports, modems, and device adapters

The screen images shown in this guide were taken from an handheld
Windows CE device. If you are using a palm-sized device the corresponding
dialogs are similar though minor differences may be present due to the change in
screen dimensions. Any differences in functionality are noted in the text.

How to Use this Guide
To get the most out of this guide, review the table of contents to familiarize
yourself with the topics discussed.

This guide contains the following sections:

Section Contents

Introduction to the Citrix ICA
Client for Windows CE

Gives a detailed list of features

Using the Citrix ICA Client for
Windows CE

Describes how to install, uninstall, and start the
Citrix ICA Windows CE Client

Configuring the Citrix ICA Client
for Windows CE

Describes how to configure connection properties
and device mappings for the Citrix ICA
Windows CE Client

Important
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Conventions
The following conventional terms, text formats, and symbols are used throughout
the printed documentation:

Convention Meaning

Bold Indicates boxes and buttons, column headings, command-line
commands and options, icons, dialog box titles, lists, menu names,
tabs, and menu commands.

Italic Indicates a placeholder for information or parameters that you
must provide. For example, if the procedure asks you to type
filename, you must type the actual name of a file. Italic also
indicates new terms and the titles of other books.

ALL UPPERCASE Represents keyboard keys (for example, CTRL, ENTER, F2).
[brackets] Encloses optional items in syntax statements. For example,

[password] indicates that you can choose to type a password with
the command. Type only the information within the brackets, not
the brackets themselves.

...(ellipsis) Indicates a command element can be repeated.
Monospace Represents examples of screen text or entries that you can type at

the command line or initialization files.
� Indicates a procedure with sequential steps.
• Indicates a procedure with only one step.
� Indicates a list of related information, not procedural steps.

The Citrix ICA Client for Windows CE allows users to connect to MetaFrame and
WINFRAME servers. When describing a feature or procedure common to
MetaFrame and WINFRAME servers, this manual uses the term Citrix server. When
describing a feature unique to a MetaFrame or WINFRAME server, this manual
specifies either a MetaFrame or WINFRAME server.

This document uses the terms click and double-click instead of tap and double-tap
to refer to the action of tapping on the Windows CE device screen with the stylus.
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Finding More Information
This manual contains conceptual information and installation and configuration
steps for the Citrix ICA Windows CE Client using a Handheld PC. For additional
information, see the following documentation:

� The Citrix ICA Client Quick Reference Cards give users step-by-step
instructions for using the Citrix ICA Clients to connect to Citrix servers and
run published applications.

� The Citrix ICA Client Administrator’s Guides.
� For instructions about installing, configuring, and maintaining your Citrix

servers, see the documentation included in your MetaFrame or WINFRAME
package.

These manuals are available in Adobe PDF format in the documentation directory
of your MetaFrame or WINFRAME CD-ROM. Using the Adobe Acrobat Reader,
you can view and search the documentation electronically or print it for easy
reference. To download the Adobe Acrobat Reader for free, please go to Adobe’s
Web site at http://www.adobe.com.

Always consult the Readme.txt files for MetaFrame, WINFRAME, and
the Citrix ICA Clients for any last-minute updates, installation instructions, and
corrections to the documentation.

Citrix on the World Wide Web
Citrix offers online Technical Support Services at http://www.citrix.com that
include the following:

� Downloadable Citrix ICA Clients, available at http://download.citrix.com
� A Frequently Asked Questions page with answers to the most common

technical issues
� An FTP server containing the latest service packs and hotfixes for download
� An Online Knowledge Base containing an extensive collection of technical

articles, troubleshooting tips, and white papers
� Interactive online support forums

Year 2000 Readiness
For a detailed description of the Year 2000 Readiness of Citrix products, see our
Web site at http://www.citrix.com/misc/y2000.htm.

Important
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Introduction to the
Citrix ICA Client for Windows CE

Overview
The Citrix ICA Client for Windows CE lets you use a Handheld PC to make an
ICA connection to a Citrix server. Once the ICA connection to the Citrix server is
established, you can access applications and work with files as if you were
working at the Citrix server itself.

Requirements
To run the ICA Windows CE Client you must have the following:

� A Windows CE-based device with a display that supports 16 or more colors or
gray scales

� A network interface card (NIC) connected to a local network using the TCP/IP
protocol or a modem and telephone for dial-in SLIP or PPP connections

� The appropriate version ICA Windows CE Client program for your Windows
CE device. Versions are available for the following processors: SH3, SH4,
X86, MIPS, PowerPC, and ARM.

Features
The Citrix ICA Windows CE Client has the following features:

� Client device mapping
� Client drive mapping
� Client printer mapping
� Client com port mapping

� Virtual screen panning
� Sound support
� Data compression  
� ICA Client hotkeys
� Transparent clipboard access
� Client auto update
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� Application publishing support
� Business Recovery

Client Device Mapping
Client device mapping allows a remote application running on the Citrix server to
access printers, drives, and devices attached to the local client computer.

Client Drive Mapping
Client drive mapping allows you to access the local disk drives of the client
computer from ICA sessions. When both the Citrix server and ICA Client are
configured to allow client drive mapping, you can access your locally stored files,
work with them from ICA sessions, and then save them either on a local drive or a
drive on the Citrix server.

Client Printer Mapping
Client printer mapping lets users access printers attached to the client computer
from applications running in an ICA session. When a Citrix server is configured to
allow client printer mapping, applications running remotely on the Citrix server
can print to local printers.

Client COM Port Mapping
Client COM port mapping is similar to printer and drive mapping. It allows users
to access serial devices on the client computer as if they were connected to the
Citrix server.

Virtual Screen Panning
Virtual screen panning allows you to overcome the small screen size of many
handheld PCs by using a screen size for the ICA session larger than the actual
screen size of the Windows CE device. If the window size is set larger than the
acutal screen size of the Windows CE device, two small rectangular boxes appear
after the ICA connection is made. The larger rectangle represents the virtual
screen of the ICA session and the smaller rectangle represents the actual
Windows CE device screen. Pen-drag the smaller rectangle to scroll the actual
screen around the virtual screen. When using a handheld PC you can hold down
CTRL and pen-drag to move the control around the actual screen.
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Sound Support
Sound support allows your client computer to play sounds generated by
applications running on the Citrix server. Sound support can be configured to use
one of three different compression schemes. Each scheme provides different
sound quality and bandwidth usage.

Data Compression
Data Compression can increase performance over low speed asynchronous and
WAN connections by reducing the amount of data sent over the communications
link to the client computer.

ICA Client Hotkeys
The Citrix Windows CE Client provides hotkeys that can be used to control
various functions while in an ICA session. Some hotkeys control the behavior of
the ICA Windows CE Client itself while others emulate standard Windows
hotkeys.

Transparent Clipboard Access
You can use the Windows CE device’s clipboard to cut and paste objects between
ICA sessions and applications running locally. Access to the local clipboard
requires no special configuration or procedures. Use the familiar cut, copy, and
paste commands to transfer text, pictures, and other objects between local and
remote applications.

Client Auto Update
The Client Auto Update feature allows administrators to update ICA Client
installations from a central location instead of having to manually install new
client versions on each client computer. New versions of Citrix ICA Clients are
stored in a central Client Update Database. The latest versions of the ICA Client
software are downloaded to ICA Client devices when users connect to the Citrix
server.
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This feature requires write access to the Windows CE device. Check with
your Windows CE device manufacturer for information about whether you can
use this feature with your device.

Published Application Support
You can create a remote application entry to connect to a Citrix server or to a
published application that contains all of the information necessary to launch a
user session or an application.

Business Recovery
The Citrix ICA Client includes the additional intelligence to support multiple
server sites (such as primary and hot backup) with different addresses for the same
published application name.

This features provides consistent connections to published applications in the
event of a primary server disruption. Users now have an even higher level of fault
tolerance and seamless user experience.

Note
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Using the Citrix ICA Windows CE Client

Overview
This section describes how to use the Citrix ICA Windows CE Client. Topics in
this section include:

� Installing the ICA Windows CE Client
� Uninstalling the ICA Windows CE Client
� Starting the ICA Windows CE Client
� Creating a new connection entry
� Connecting to a Citrix Server

Installing the ICA Windows CE Client
The ICA Windows CE Client can be installed using one of two methods:

� Local Installation. The installation program is run on the Windows CE device
from a previously downloaded setup file.

� PC installation. This method can only be used with Windows CE devices
attached to a PC. The installation program is run on the PC, which then
downloads the necessary files to the Windows CE device.

After the ICA Client is installed, the first time you run the ICA Client you are
prompted to enter a unique name for your device. This name must not be in use by
any other ICA Clients on the network.

���� To install the ICA Windows CE Client using the local installation method
1. Copy the ICA Windows CE Client setup program (icasetup.processor.cab,

where processor is the processor type for your Windows CE device) to the
Windows CE device.

2. On the Windows CE device, double-click the icasetup.processor.cab icon.
3. Specify the directory in which to install the ICA Client and click OK.
4. The license agreement appears. Click Accept to accept the license agreement

and continue installation.
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���� To install the ICA Windows CE Client using the PC installation method
1. Double-click the ICA Setup icon on your PC and follow the instructions that

appear. The necessary files are downloaded to the Windows CE device.
2. Once installation is complete, on the Windows CE device click Start,

Programs, ICA CE Client, and then Remote Application Manager.
3. When prompted, enter a unique name for your device and click OK. The name

must not be in use by any other ICA Clients on the network.

Uninstalling the ICA Windows CE Client
���� To uninstall the ICA Windows CE Client

1. Click Start, Settings, and then Control Panel.
2. The Control Panel appears. Double-click Remove Programs.
3. Select Citrix Systems ICA Client and click Remove.
4. Click OK to complete uninstallation.

Starting the ICA Windows CE Client
���� To start the ICA Windows CE Client

• Click Start, Programs, ICA CE Client, and then Remote Application
Manager.

Creating a New Connection Entry
You can configure and run two types of ICA sessions: Citrix server connections
and published applications.

� Citrix server connections allow you to connect to the Windows desktop of a
specific Citrix server; you can run any applications available on the desktop, in
any order.

� Published applications are specific applications set up by an administrator for
remote users to run. When connected, you are presented with the application
itself.
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This procedure describes the simplest way to create a connection entry.
When you follow these steps, you set the essential items you need to connect to a
Citrix server from the Windows CE device, See “Changing a Connection Entry”
for more information about how to change the other properties for a connection
entry.

���� To create a new connection entry
1. On the Entry menu, click New.
2. The Specify Connection Type dialog box appears:

Click Network Connection to make a network connection. Make sure your
client device is connected to the network through a network interface card
(NIC) or by a serial PPP connection to a Windows 95 or Windows NT RAS
server. Click Next to continue. Skip to Step 4.
— or —
Click Dial-In Connection to make a dial-in connection. Make sure your
modem is installed and properly configured. Click Next to continue.

The ICA Windows CE Client does not support modem callback. When
using modem callback, the server hangs up on dial-in connections at logon and
then dials a specified number to reconnect to the user attempting to log on.
Because Windows CE contains no mechanism to answer the return call, the
ICA Windows CE Client does not support modem callback for dial-in
connections.

Note

Note



Citrix ICA Client for Windows CE  15

3. The Dial-In Devices page appears:

From the pull-down list, select your modem. In the Phone Number box, type
the area code, phone number, and country code of the Citrix server. Click Next
to continue. Skip to Step 7.

4. The Select a Citrix Server or Published Application page appears:

5. Click Citrix Server to connect to a server or Published Application to
connect to a published application.

6. Scroll through the list and select the Citrix server or published application to
which you want to connect or type the name of the Citrix server or published
application in the box. Click Next to continue.
If the server or published application to which you want to connect is not
listed, your Windows CE device may not be on the same network as the Citrix
server to which you want to connect. This is likely if you are connecting across
a router or the Internet. If this is the case, see “Configuring Business
Recovery” later in this chapter.
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7. The Select a Title for the ICA Connection page appears:

Enter a name for the connection entry. The name you choose is the name of the
entry in the Current Client Connections list and appears in the title bar of the
ICA session window.
Click Create a shortcut to this ICA connection on the Desktop to create a
shortcut to this connection entry on the Windows desktop. You can then use
the shortcut to start the ICA session without having to first run Remote
Application Manager. Please note that if you are using a palm device this
option will not be available.

8. Click Finish to save the entry or Cancel to exit the new connection entry
dialog box without saving the entry.

Once you have created a connection entry, the name appears in the list of
connections in Remote Application Manager.

Connecting to a Citrix Server
���� To start a previously defined connection

1. Click the name of the connection entry that you want to use.
2. On the Entry menu, click Connect.

If you specified a valid user name and password in the connection entry, you
are logged in as that user.
If no user name and password are present in the entry or the information is
incorrect, the server logon dialog box appears. Enter a valid user name and
password for the Citrix server and click OK to log on.
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Configuring the
Citrix ICA Client for Windows CE

Overview
This section describes how to configure the Citrix ICA Windows CE Client.
Topics in this section include:

� Changing an existing connection entry
� Changing the default settings

Changing a Connection Entry
This section describes how to change the properties of an existing connection
entry.

���� To change the properties of a connection entry
1. Click the name of the connection entry that you want to change.
2. On the Entry menu, click Properties to display the Edit Connection Details

dialog box.

3. Make the desired changes.
4. Click OK to save your changes.
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The Edit Connection Details dialog box contains the following tabs:

� The Server tab (network connection entries only), where you can set the
Server or published application name to which to connect. There is also a
button to display the Server Location dialog box where you can set Business
Recovery options, See “Creating a New Connection Entry” and “Configuring
Business Recovery” for more information.

� The Dial-in tab (dial-in connection entries only), where you can set the area
code, country code, and telephone number to dial. You can use the settings on
this page in the same way as when you first set up the connection entry, See
“Creating a New Connection Entry” for more information.

� The Application tab, where you can specify an application to run after
connecting to a Citrix server, See “Specifying an Application to Run after
Connecting to a Citrix Server” for more information.

� The Logon tab, where you can set the user name, password, and domain to use
to log in to the Citrix server automatically, See “Specifying Logon
Information” for more information.

� The Window tab, where you can set the size and number of colors used for the
ICA session window, See “Changing the Window Properties” for more
information.

� The Options tab, where you can control the connection between the Citrix
server and Windows CE device and configure sound support, See “Setting
Connection Entry Options” for more information.

� The Title tab, where you can change the name of the connection. The name
appears in the list in the Connection Manager dialog box.

� The Firewall Settings tab, where you can configure the client to use a SOCKS
proxy and alternate address remapping, See “Configuring Firewall Settings”
for more information.

Specifying an Application to Run after
Connecting to a Citrix Server

Use the Application tab to specify an application to run after connecting to a
Citrix server. If you specify an application, you do not see the Windows desktop
when you connect and the connection is closed when you exit the application.

This tab does not apply to connection entries for published applications.
Any values entered are ignored.
Note
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���� To specify an application to run after connecting to a Citrix server
1. Click the name of the connection entry that you want to change.
2. On the Entry menu, click Properties to display the Edit Connection Details

dialog box.
3. Click the Application tab.

4. In the Command Line box, specify the path and file name of the application to
be run after connecting to the Citrix server. For example, to launch Notepad
automatically after connecting to the Citrix server, type:
C:\Wtsrv\Notepad.exe

5. In the Working Directory box, specify the working directory to be used with
the application. If you use Notepad to work on documents in the C:\My
Documents directory, type C:\My Documents.

6. Click OK to save your changes.

When you log on to the Citrix server, Notepad begins. In Notepad, if you select
Open from the File menu, the C:\My Documents directory is displayed.

Specifying Logon Information
You can include the settings needed to log on to the Citrix server as part of the
connection entry. This saves time when connecting to the server but is less secure.

���� To specify logon information
1. Click the name of the connection entry that you want to change.
2. On the Entry menu, click Properties to display the Edit Connection Details

dialog box.



20  User’s Guide

3. Click the Logon tab.

4. Enter a valid user name, domain, and password. If you leave these boxes blank,
you are prompted for your user name, domain, and password each time you
connect to the Citrix server or published application.

5. Click OK to save your changes.

Changing the Window Properties
Use the Window tab to change the window size and number of colors to use for
ICA connections made using the connection entry.

���� To specify the Window properties for a connection entry
1. Click the name of the connection entry that you want to change.
2. On the Entry menu, click Properties to display the Edit Connection Details

dialog box.
3. Click the Window tab.

4. In the Window Size box, set the window size either in pixels or as a
percentage of the actual screen size of the Windows CE device.
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If the window size is set larger than the acutal screen size of the
Windows CE device, the virtual screen control is displayed in the ICA session
window. This control allows you to pan the actual screen around the larger
virtual screen of the ICA session, See the section “Virtual Screen Panning” for
more information.

5. In the Window Colors box, set the number of window colors to 16 or 256.
6. Click OK to save your changes.

Setting Connection Entry Options
Use the Options tab to set options specific to the connection entry, such as data
compression and sound support.

���� To set connection entry options
1. Click the name of the connection entry that you want to change.
2. On the Entry menu, click Properties to display the Edit Connection Details

dialog box.
3. Click the Options tab.

4. Click Compress Data Stream to reduce the amount of data transferred
between the ICA Client and the Citrix server.
If your connection is bandwidth-limited, enabling compression can increase
performance. If your client device is on a high-speed LAN, you may not need
compression. If you have sufficient bandwidth, leave compression off to
conserve processing power on the Citrix server.
The Cache feature is not supported in this release.

Note
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Click Enable Sound to enable sound support. From the pull-down list, select
one of the following quality levels.
� High. This value provides the greatest audio quality but should be used

only when bandwidth consumption is not a concern.
� Medium. Using this value results in less bandwidth consumption than

when using High. Compression of sound data provides greater bandwidth
efficiency but reduces sound quality somewhat. This value is recommended
for most LAN-based connections.

� Low. This value offers the most efficient use of bandwidth but also
decreases sound quality severely. This value is recommended for low-
bandwidth connections, including most modem connections.

The Encryption feature is not supported in the Windows CE client.
 5. Click OK to save your changes.

Configuring Business Recovery
The ICA Windows CE Client uses the information entered in the Server Location
dialog box to locate available Citrix servers and published applications.

Each Citrix server runs the ICA Browser service. This service maintains a list of
available Citrix servers and published applications on the network. The master
browser service acts as a central information store by maintaining the list and
periodically obtaining updates from the other servers.

Each Citrix ICA Client must locate the master browser to get the address of a
server or published application. By default, the client can automatically locate the
master browser by sending out broadcast packets. If you are connecting across a
router or the Internet, these broadcast packets may not reach the Citrix servers.
Business Recovery allows you to manually define a list of servers to contact to
determine the master browser. You can define up to three groups of Citrix servers
to which you want to contact: a primary and two backups.

When you configure Business Recovery, the client attempts to contact all the
servers within the Primary group using directed packets; the first server to respond
is then queried for the address of the master ICA Browser. If none of the servers
respond, the client attempts to contact all the servers within the Backup 1 group. If
there is still no response, the client attempts to contact all of the servers in the
Backup 2 group. This process is repeated each time the user attempts to make an
ICA connection.

Business Recovery options can be set for a particular connection entry or all
connection entries. If both are set, the settings for the connection entry are used.
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���� To set Business Recovery options for all connection entries
1. On the View menu, click Settings to display the Global ICA Client Settings

dialog box.
2. Click the Server Location tab.

3. On the Server Group list, select the server group you want to configure.
4. Click Add to add a server to the selected group. The Add Server Address

dialog box appears.
5. Enter the name or address of a Citrix server and then click OK.
6. Add more servers as necessary.
7. Click OK to save your changes.

���� To set Business Recovery options for a specific connection entry
1. Click the name of the connection entry that you want to change.
2. On the Entry menu, click Properties to display the Edit Connection Details

dialog box.
3. Click the Server Location tab.
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4. Click Server Location to display the Server Location dialog box.

5. Follow the instructions for the procedure above beginning with Step 3.

Configuring Firewall Settings
Configuring the ICA Client to Use a SOCKS Proxy
If you are using a SOCKS proxy server to limit access to your Citrix servers, you
must configure the ICA Client to connect to Citrix servers through a SOCKS
proxy server. You can configure a default SOCKS proxy for all connections or use
only a SOCKS proxy with a specific connection file.

���� To configure a default SOCKS proxy server
1. On the View menu, click Settings to display the Global ICA Client Settings

dialog box.
2. Click the Firewall Settings tab.

3. Click Connect via SOCKS proxy.
4. In the Address of proxy to use box, enter the SOCKS proxy server’s IP

address or DNS name.
5. In the Port box, enter the proxy server’s port number (if different than 1080).
6. Click OK to save your changes.
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If you configure a default SOCKS proxy, you must specify at least one
server in the Server Location tab for server and published application browsing
to work.

���� To configure a SOCKS proxy for a specific connection entry
1. Click the name of the connection entry that you want to change.
2. On the Entry menu, click Properties to display the Edit Connection Details

dialog box.
3. Click the Firewall Settings tab.

4. Follow the instructions for the procedure above beginning with Step 4.

Configuring Alternate Address Translation
If the ICA Client is outside a firewall that uses address remapping, you must
configure the ICA Client to use the alternate address returned by the master ICA
Browser. This is necessary even if you are not using a SOCKS proxy server.

You must also use the ALTADDR utility to manually set the alternate
address for each Citrix server, See the Command Reference appendix of either the
MetaFrame Administrator’s Guide or the WINFRAME System Guide for more
information.

If you set alternate address translation for all connection entries, it cannot be
disabled for specific connection entries.

���� To use alternate address translation for all connection entries
1. On the View menu, click Settings to display the Global ICA Client Settings

dialog box.
2. Click the Firewall Settings tab.
3. Click Use alternate address for firewall connection.

Note

Note

Note
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4. Click OK to save your changes.

���� To use alternate address translation for a specific connection entry
1. Click the name of the connection entry that you want to change.
2. On the Entry menu, click Properties to display the Edit Connection Details

dialog box.
3. Click the Firewall Settings tab.
4. Click Use alternate address for firewall connection.
5. Click OK to save your changes.

Changing the Global Settings
This section describes how to change settings that apply for all connection entries
on the Windows CE device. It also describes how to change the default settings
that are used when creating new connection entries. You may want to do this if
you always prefer to use a particular setting; for example, a larger default window
size.

���� To change the global settings
1. On the View menu, click Settings to display the Global ICA Client Settings

dialog box.

2. Make the desired changes.
3. Click OK to save your changes.

The Global ICA Client Settings dialog box contains the following tabs:

� The Default Hotkeys tab, where you can define alternative key combinations
for system hotkeys, See “Configuring Hotkeys” for more information.

� The Preferences tab, where you can control the default window and settings
used for new connection entries, See “Configuring Global Preferences” for
more information.
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� The Server Location tab, where you can configure Business Recovery
options, See “Configuring Business Recovery” earlier in this section for more
information.

� The Firewall Settings tab, where you can configure the client to use a SOCKS
proxy and alternate address remapping, See “Configuring Firewall Settings”
earlier in this section for more information.

Configuring Hotkeys
The ICA Windows CE Client provides users with hotkeys that can be used during
ICA sessions to control various functions. Some hotkeys control the behavior of
the ICA Windows CE Client itself while others emulate standard Windows
hotkeys. When you want to use a Microsoft Windows key combination during a
session, use the mapped hotkey instead. The following table lists the default ICA
Windows CE Client hotkeys.

If you have a palm-sized device you can enter Hotkeys using the Keyboard Input
Panel.

Name
Default
Value Description

Status Dialog CTRL+6 Displays ICA Client connection status.
Close Remote
Application

CTRL+2 Disconnects the ICA Windows CE Client from the
Citrix server and closes the client window on the local
desktop. Using this hotkey leaves the ICA session
running in a disconnected state on the Citrix server. If
you do not want to leave your session running in a
disconnected state, log off instead.

Toggle Title Bar CTRL+3 Alternately hides and displays the ICA session window
title bar. Remove the title bar to maximize your work
space.

CTRL-ALT-DEL CTRL+4 Displays the Windows NT Security dialog box on the
Citrix server.

CTRL-ESC CTRL+5 On MetaFrame servers, the Windows Start menu is
displayed. On WINFRAME servers, this hotkey displays
the Task List.

ALT-ESC CTRL+7 This hotkey cycles the focus through the minimized
icons and open windows of applications run in your ICA
session.

ALT-TAB CTRL+8 This hotkey cycles through all applications in the ICA
session. A pop-up box appears and displays the
programs as you cycle through them. The selected
application receives keyboard and mouse focus.
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Name
Default
Value Description

ALT-BACKTAB CTRL+9 Like the ALT+TAB hotkey, this key sequence cycles
through applications that have been opened in the ICA
session, but in the opposite direction. The chosen
application receives keyboard and mouse focus.

���� To change the default hotkeys
1. On the View menu, click Settings to display the Global ICA Client Settings

dialog box.
2. Use the lists of keys to customize the default hotkey key sequences.
3. Click OK to save your changes.

Configuring Global Preferences
The following settings are configured in the global Preferences tab:

� Default Window Colors. In the Window Colors box, select 16 or 256 colors.
When using a PPP connection, 16 color mode may provide better performance.
If the window options specified exceed the capabilities of the client hardware,
the maximum color depth supported by the Windows CE device are used
instead.

� Serial Number. This is the serial number of your ICA Client software. This
number is only necessary when you are using the ICA Windows CE Client
with a product such as WINFRAME Host/Terminal, which requires each ICA
Client to have a Citrix PC Client Pack serial number. If a serial number is
required, you must enter it exactly as it appears on the Serial Number card. The
serial number is not used when connecting to MetaFrame servers.

� Client Name. This box allows you to set the name of your client device. Citrix
servers use the client name to uniquely identify resources (such as mapped
printers) associated with a given client device. The client name should be
unique for each computer running a Citrix ICA Client. If you do not use
unique client names, device mapping and application publishing may not
operate correctly.

� Enable Palette Device. If your device has a configurable hardware palette,
check this box to increase graphic presentation performance. If no hardware
palette is present on the device, enabling this feature causes graphics to display
incorrectly.

� Allow Automatic Client Updates. Check this box to allow the client software
at this workstation to be automatically updated when a newer version is
available, See “Preparing for Client Auto Update” later in this section for more
information.
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���� To change global preferences
1. On the View menu, click Settings to display the Global ICA Client Settings

dialog box.
2. Click the Preferences tab.

3. Make the desired changes.
4. Click OK to save your changes.

Preparing for Client Auto Update
This version of the ICA Windows CE Client software can be set up so that you
can automatically update it from the server when a newer version is available.
This means that you are  able to “push” a new version of the client software from
a central database to the Windows CE device instead of installing the client
manually at each device.

This feature requires write access to the Windows CE device. Check with
your device manufacturer to find out whether you can use this feature for your
device.

���� To enable the ICA Windows CE Client software for automatic update
1. On the View menu, click Settings to display the Global ICA Client Settings

dialog box.
2. Click the Preferences tab.

Note
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3. Check Allow Automatic Client Updates to allow the client to be
automatically updated with a newer version from the Citrix Server.

Note that this does not affect this version of the ICA Windows CE Client.
The feature prepares the system for future client updates. Instructions describing
how to configure a client update database and roll-out new client software will
accompany future versions of the ICA Windows CE Client.

Using Local Printers
Client printer mapping lets you access printers attached to your client device from
an ICA session. When a Citrix server is configured to allow client printer
mapping, applications running remotely on the Citrix server can print to local
printers.

���� To view mapped client printers when connected to a MetaFrame server
• While connected to a MetaFrame server, double-click My Computer on the

remote desktop and then double-click Printers. The Printers dialog box
appears.
The Printers dialog box displays the mapped local printers along with any
other printers available on the MetaFrame server. The name of the printer is
clientname#port, where clientname is the name you have assigned to your ICA
Client and port is the printer port on your Windows CE device, for example
COM1 or LPT1.

���� To view mapped client printers when connected to a WINFRAME server
• While connected to the WINFRAME server, double-click Print Manager in the

Main program group of Program Manager. Print Manager displays the local
printers mapped to the ICA session.
The name of the printer is clientname#port, where clientname is the name you
assigned to your Windows CE device and port is the printer port on your
Windows CE device.

Note
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If your client printer is not automatically mapped on the Citrix server, you can
manually map it in the ICA session. Use the following procedures to manually
map a client printer.

���� To manually map a client printer on a MetaFrame 1.8 or WINFRAME 1.8
server
1. Log on to the Citrix server.
2. On a MetaFrame server, click Start, Programs, MetaFrame Tools, and then

ICA Client Printer Configuration.
— or —
On a WINFRAME server, double-click ICA Client Printer Configuration in
the Administrative Tools program group of Program Manager.

3. On the Printer menu, click New to display the Add ICA Client Printer wizard.
Follow the steps in the wizard to map the client printer.

���� To manually map a client printer on a MetaFrame 1.0 server
1. Log on to the MetaFrame server.
2. In the ICA session window, double-click My Computer and then double-click

Printers.
3. Double-click Add Printer. Select Network printer server and click Next.
4. In the Shared Printers box, double-click Client Network and then double-

click Client.
5. Select clientname#port, where clientname is the name you assigned to your

Windows CE device and port is the printer port on your Windows CE device,
and then click OK.

6. If you want this printer to be your default printer, click Yes.
7. Click Next and then click Finish.

���� To manually map a client printer on a WINFRAME 1.7 server
1. Logon to the WINFRAME server.
2. In the ICA session window, double-click Print Manager in the Main program

group of Program Manager.
3. On the  Printer menu, click Create Printer.
4. In the Shared Printer list, double-click Client.
5. Double-click the required printer, and then click OK.
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